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Introduction

Introduction
APM Plainwhat is it?

А

PM Plain is the system for plain bearing calculation developed in the
APM Ltd Research and Software Development Center.

Using APM Plain you can calculate plain bearings of the following types:
• radial bearing of complete lubrication
• radial bearing of incomplete lubrication
• thrust bearing of complete lubrication
With APM Plain the most importing bearing parameters can be calculated including:
• clearance distribution,
• oil consumption,
• average and maximum oil temperature,
• loss of power,
• axial beatings, etc.

Hardware and software requirements
Hardware minimum: Pentium 266 MHz, RAM 64 Mb. Software: MS Windows-9X ,Me;
MS Windows-NT(SP-6), 2000, XP.

What's in this manual
Introduction (this section) tells you what APM Plain is in general, what parameters and
what types of bearings could be calculated. You will know the requirements to hardware and
system software are listed.
Chapter 1, Problems, initial data and results contains description of the problems
solved with APM Plain. The strict definitions of all calculated parameters and initial data are
given. Presentation of the results is described.
Chapter 2, Command reference contains complete description of all commands of the
main menu and popup menus.
In the Appendix warnings and error messages generated by APM Plain are listed.

Typefaces used in this book
To facilitate reading and avoid misunderstanding we use a set of typefaces. Their uses
are as follows.
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a:\setup

This typeface represents text as it appears or anything you
must type (for example, a:\setup to start installation
program).

SETUP.EXE

We use all capital letters for the names of files and keys.

Help

APM Plain command names are shown in boldface.

Results

Italics is used for the names of dialog boxes and controls

How to contact APM
To contact APM you can use one of the following ways:
Send fax. Our Moscow fax number is +7(495) 585-06-11.
Call by phone +7(495) 585-06-11 (Moscow) or +7(495) 514-84-19 (Moscow).
Write a letter and send it to
Research and Software Development Center APM LTD
Korolev-Center, box 58,
Moscow Region
141070 Russia
Use E-mail: com@apm.ru, com@apmwm.com.
Visit our web-site: http://www.apm.ru, http://www.apmwm.com.
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Chapter 1

Problems, initial data and results

B

earing is a shaft support, that takes the load, applied to the shaft and provides its
rotation. Depending on the mode of friction all bearings are divided into two main
groups rolling contact bearings and plain bearings. In the former rolling friction
take place, whereas in the lattersliding friction. In the plain bearing the shaft
and the shell are separated with a film of liquid. Usually oil is used for the purpose, in special
cases other liquids can be used.
The optimum operation mode of those bearings is that of complete liquid lubrication. It
prevents the contact of the elements and theirs wearing and minimizes friction coefficient.
When oil film has breaks and relative movement of bearing elements is accompanying
with theirs contact, corresponded mode is called semi-liquid lubrication mode. This mode
increases wearing and heat release, it is accompanied with high energy losses and risk of
fretting's appearance. In contrast to latter the complete liquid lubrication mode requires forced
oil supply, that considerably limits it’s application. In some constructions plain bearings don’t
require lubrication since they are manufactured of metal materials with low friction coefficient
and high wear resistance.This operating mode is called dry friction mode.
APM Plain is intended for complete design of plain bearing. In the system checking
calculations are implemented, i.e. we determine main output characteristics for bearing with
given dimensions, given loads applied and produced of given material.
With APM Plain you can calculate the following types of plain bearings:

• radial bearings with complete liquid lubrication
• radial bearings with semi-liquid lubrication
• thrust bearings with complete liquid lubrication

Complete liquid lubrication mode
Load-carrying capacity of bearing running in this mode is determined through laminar
flow problem solution for sliding support. The method includes corrections that take into
account oil leakage through the end faces. Sliding support is considered appropriate if the
minimum clearance in working state is greater then the sum of heights of microroughness of
the shaft and shell by 1.5 times and more. Also oil temperature is calculated from the
equation of heat balance; it must be less than allowable value for chosen oil brand.
If conditions listed above are not satistied, then either bearing dimensions should be
changed or forced cooling should be used.
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Semi-liquid lubrication mode.
Methods of load-carrying capacity calculation for plain bearing running in semi-liquid
lubrication mode are based on the experimental data relating contact interaction of surfaces
being in relative movement in the presence of limited quantity of the oil. These problems
include the friction problem as well as heat transfer problem, that is tied with the former.
Moreover contact interaction is accompanying by wear, it’s calculation will be included in the
next version of the system.
By performing results analysis for a number of different variants it is possible to select
the best one and to get rational construction of plain bearing.
Below we give a brief description of initial data and calculation results.

Bearing types
As mentioned above with APM Plain you can calculate the plain bearings of two
types:

• radial bearings that operate in the modes of complete and incomlete lubrication
• thrust bearings

Fig. 1.1 Plain bearings of radial and thrust types
The initial data used to calculate plain bearings can be divided into three groups:
• geometry data
• data that characterize working conditions
• oil parameters

Geometry
This group includes dimensions of bearing and shaft as well as manufacturing errors
of working surfaces.

Shaft diameter
The outer diameter of the shaft zone that takes oil pressure.
Measurement units - millimeters (mm).

Contact zone length
The length of the shaft zone that takes oil pressure.
Measurement units - millimeters (mm).

Outer diameter
The diameter that define outer boundary of zone of hydrodynamic reaction.
Measurement units - millimeters (mm).

Inner diameter
The diameter that define inner boundary of zone of hydrodynamic reaction.
Measurement units - millimeters (mm).
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Lubrication groove width
The width of groove included in the non-working zone.
Measurement units - millimeters (mm).

Noncylindricity of the shaft
Maximum distance between real surface of the shaft and adjusting cylinder.
Measurement units - millimeters (mm).

Nonperpendicularity to A, B
Perpendicularity error of referenced surfaces.
Measurement units - millimeters (mm).

Surface finish
Surface finish of working surfaces that depends on microroughness of shaft. As a
measure of microroughness Ra value is used that is the mean value of profile deviation
moduluses along the base length.

Working conditions
To describe conditions plain bearing works at the following parameters are used:

Radial force
The force that is perpendicular to rotation axis and directed to rotation center.
Measurement units - Newton (N).

Axial force
The force directed along the shaft axis.
Measurement units - Newton (N).

Rotational speed
The number of shaft revolutions per unit time.
Measurement units - revolutions per minute (rpm).

Friction coefficient
The ratio of friction force to normal reaction that arises in the contact of conjugated
bodies. This parameter is dimensionless.

Housing surface area
The area of outer surface of bearing housing.
Measurement units - square meters (sq.mm).

Environment temperature
The air temperature in the place the bearing is mounted.
Measurement units - Celsius degrees (deg).

Young's modulus
Modulus of elasticity.
Measurement units - megaPascales (MPa).

Maximum allowable load
The stress exceeding of which caused plastic deformations in the thrust bearing.
Measurement units - Pascales (MPa).

Oil temperature
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Maximum temperature of oil film in stationary mode.
Measurement units - Celsius degrees (deg).

Oil feed pressure
Exceeding pressure of oil at the entry in the working zone of bearing.
Measurement units - Pascales (MPa).

Contact angle of oil film
The angle that determines the length of the working surface.
Measurement units - degrees (deg).

Minimum thickness of oil film
Minimum thickness of oil film in the working zone of bearing.
Measurement units - millimeters (mm).

Thermal conductivity
Heat transfer from more heated zones of a body to less heated ones.
Measurement units - Watt per square meter degree (W/sq.m x deg).

The number of slopes
Construction parameter that determines the number of oil wedges balancing external
load.

Inclination ratio
Construction parameter that is equal the ratio of maximum clearance to minimum
one.

Oil parameters
To describe properties of oil used for bearing lubrication the following data are used:

Heat capacity
The quantity of heat absorbed by the body of unit mass during heating by one degree.
Measurement units - Joule per kilogramm degree ( J/kg x deg ).

Oil density
The mass of unit volume of material.
Measurement units - kilogramm per cubic meter (kg /cub.m)

Viscosity
The ability of the liquid to resist relative displacement of its layers. Dynamic viscosity
is equal to tangent stress that should be applied at the surface of the liquid in order to get unit
gradient of layer displacement velocity.
Measurement units - Pascal seconds (Pa x sec)

Oil feed method
Determine the method of oil feed: whether oil is directed to working zone or to nonworking zone.
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Results
Using APM Plain you can calculate the following parameters:

А)Radial bearing working in the complete lubrication mode
Minimum thickness of oil film - hmin

Minimum thickness of oil film between surfaces in contact.
Measurement units - millimeters (mm).

Critical thickness of oil film - hcr

Minimum thickness of oil film thickness that leads to transition from mode of complete
lubrication to mode of semi-liquid lubrication.
Measurement units - millimeters (mm).

Recommended radial clearance
The clearance that is optimum for efficient operating of bearing.
Measurement units - millimeters (mm).

Maximum oil temperature
Maximum temperature in the working zone of bearing.
Measurement units - Celsius degrees (deg).

Average oil temperature
Average temperature in the working zone of bearing.
Measurement units - Celsius degrees (deg).

Loss of power
The power require to surmount the action of friction forces in the bearing.
Measurement units - kilowatt (kWt).

Oil cosumption
The volume of oil that flows through the bearing per unit time.
Measurement units - cubic meter per second (cub. m/sec).

Radial clearance distribution
B) Radial bearing working in the incomplete lubrication mode:
True friction coefficient
True value of friction coefficient between shaft and shell.

Relative diameter clearance
The ratio of radial clearance to the diameter of the shaft.

Shell diameter
Inner diameter of bearing shell.
Measurement units - millimeters (mm).
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Average oil temperature
Average temperature in the working zone of bearing.
Measurement units - Celsius degrees (deg).

Average pressure in bearing
The ratio of average radial force to base area of bearing.
Measurement units - megaPascales (MPa).

C)Thrust bearing:
Slope angle - αс

Measurement units - degrees (deg).

Average temperature of oil
Average temperature in the working zone of bearing.
Measurement units - Celsius degrees (deg).

Minimum thickness of oil film
Minimum thickness of oil film thickness that leads to transition from mode of complete
lubrication to mode of semi-liquid lubrication.
Measurement units - millimeters (mm).

Minimum thickness of oil film
Minimum thickness of oil film thickness that leads to transition from mode of complete
lubrication to mode of semi-liquid lubrication.
Measurement units - millimeters (mm).

Complete oil consumption
The volume of oil that flows through the bearing per unit time.
Measurement units - cubic meter per second (cub. m/sec).

The slope of plane area - θ1
Measurement units - radians (rad).

Slope angle - θ2
Measurement units - radians (rad).

Radial clearance distribution
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Chapter 2

Command reference
This section includes a complete description of all menu commands and dialog box
options in the APM Plain environment. Fig. 2.1 shows the main menu of the APM Plain and
all the pulldown menus called from the main menu.

Figure 2.1 APM Plain menu structure

File menu
The File menu includes commands for
• loading information from archive files
• saving information to archive files
• printing initial data and calculation results
• choosing printer and printing options
• quitting the program

Fig. 2.2 The File menu

Save Data command
This command saves archive file by calling Save Archive File dialog box. See Microsoft
Windows User's Guide to get more detail.
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Load Data command
This command loads archive file by calling Load Archive File dialog box. See Microsoft
Windows User's Guide for more information.

Print command
This command prints program resume. Print dialog box appears on the screen after
choosing that command.

Print Setup command
This command lets you setup your printer. Printer Setup dialog box appears on the
screen after choosing that. For more information see Microsoft Windows User's Guide.

Exit command
This command terminates the program.

Data menu
The Data command of the main menu invokes Data popup menu shown at Fig. 2.3.
This menu contains commands that allow to enter initial data.

Fig. 2.3 The Data menu

Type command
This command lets you choose type of bearing to be calculated. Select Bearing Type
dialog box appears on the screen (Fig.2.4).

Fig. 2.4 The Select Bearing Type dialog box

Geometry command
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This command lets you enter parameters concerning geometry of the bearing.Bearing
Geometry dialog box appears on the screen (Fig.2.5). In this dialog box you can enter data
that describe bearing dimensions and accuracy.

Fig. 2.5 Bearing Geometry dialog box
If you select Additional Parameters... button Additional Parameters dialog box appears
on the screen (Fig.2.6). It allows you enter radial clearance. If you skip this step, clearance
value will be determined by the program basing on geometry and working conditions. This
value will be displayed in the Results dialog box.

Fig. 2.6 Bearing Geometry (additional parameters) dialog box

Working Conditions command
This command lets you enter parameters concerning bearing working conditions.
Bearing Working Conditions dialog box appears on the screen (Fig.2.7).

Fig. 2.7 Bearing Working Conditions dialog box
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If you select Additional Parameters... button Additional Parameters dialog box appears
on the screen. Using it you can change value of the contact angle of oil film (see Chapter 1).
By default this parameter is set to 120 deg.

Fig. 2.8 Bearing Working Conditions (additional parameters) dialog box

Oil parameters command
This command lets you enter parameters concerning properties of oil used for
lubrication. Oil Parameters dialog box appears on the screen (Fig.2.9).

Fig. 2.9 The Oil Parameters dialog box
In the General parameters group you should enter heat capacity and density of the oil.
To specify dynamical viscosity you can use two wayseither by oil brand selecting or
by entering two viscosity values that correspond to two different temperatures. To point out
method of viscosity determination use radio buttons of Data Type group box. If you select Oil
Brand button you should specify desired brand in the Select Oil Brand list box. When you
have selected Oil Parameters button you should enter two values of viscosity that correspond
to two different temperatures. You can enter these values immediately in the edit boxes of
Additional Parameters group box. You can also define these values on the graph that is
displayed if you select Define Dependency button.
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Fig. 2.10 The window used to determine TemperatureViscosity dependence
The window used to specify TemperatureViscosity dependence is shown in fig.2.10.
Use mouse to enter two points that will be used to restore TemperatureViscosity
dependence.
The window includes rulers, scroll bars, status bar and toolbar. Horizontal ruler shows
temperature in degrees, vertical onedynamic viscosity in Pa x sec. Values of temperature
and viscosity that correspond to current cursor position are displayed in the status bar.
Toolbar buttons functions are as follows:
confirm entered values and closes the window
change scale of the graph
change step and appearance of auxiliary grid
delete the points
You can delete entered points by clicking with mouse right button as well.
For radial bearings of liquid friction you should choose additionally what kind of oil
supply will be used: to working zone or to non-working zone, to do this use radio buttons of
the Oil supply to.. group.

Calculation command
Calculation command initiates bearing calculation. It becomes enabled after you enter
all the initial data. During calculation progress bar is displayed that shows current calculation
percentage.
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Results command
Results command displays Results dialog box (see fig.2.11). The command become
enabled after calculation performing.

Fig. 2.11 The Results dialog box

Help menu

Fig. 2.12 The Help popup menu

Contents command
Help | Contents command invokes on the screen APM Plain help contents.

About... command
Help | About... command displays About dialog box. It contains information about
program and licence holder.
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